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Section 1: Tutorials 

1.1. How to Cut with a Laser Machine 

Step 1. The Software 

Open the laser software provided with your machine.  

This software will have been installed onto your computer by a trained 

CTR technician when your laser machine was delivered and installed. 

 

Step 2. The Laser Machine 

If you have a fume filtration system, make sure this system is connected 

to your laser machine and fully set up. 

 

Switch on the laser machine and water cooler unit. 

 

Switch on the fume filtration system. 

 

Step 3. Focus the Lens 

Place the material you want to work with flat on the laser machine bed. 

Focus the laser machine lens - focus instructions are available on the 

software disc provided with your laser machine, in the “Settings” folder 

(please see the “Adjusting the Lens Focus Height” article). 

WARNING: Ensure that the bed is at the correct height that the laser 

machine lens barrel can easily clear the highest point of the material. 

Failure to do this may result in damage to the laser machine or materials 

being worked on. 

 

Step 4. Creating the Cut File 

Open or create a file to be cut - if you are running a first test, you could try 

drawing a box, with a smaller circle inside it, to cut.  

 

If you are importing a file to be cut, we recommend you use DXF file 

format. Please note that only vector lines can be cut. 

 

Step 5. Settings 

You can select individual shapes and click on a different colour from the 

colour panel on the right of the software screen to put the graphics on 

different layers. This means you can set a different speed and power for 

each different layer (for each coloured graphic). 

 

In the top right of the software screen, each colour actively being used in 

the software will be shown in a list. Click on the drop-down menu for each 

coloured row to select these items to be Cut.  

NOTE: the laser software will run the graphics according to the order of 

this colour list, the top colour first, working down to the last colour in the 
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list. 

 

Double click on the settings for each coloured row to set the speed and 

power parameter settings, according to the type and thickness of material 

which you are using. 

 

Step 6. Set the Origin for the Laser Head 

If “Immediate” is ticked: the laser machine will cut the graphics starting 

from the current location of the laser machine head. 

Use the arrow keys on the laser machine control panel to move the laser 

head into the desired position. You must ensure that the laser machine 

has enough room to cut the file which you want to run, and also make 

sure that the file is not too big for the piece of material being used. You 

can test this by pressing the “Outline” button on your laser software. 

 

If “Immediate” is not ticked: the laser machine will cut the graphics in the 

location that they are placed on the laser machine software window.  

 

NOTE: you can find the “Immediate” tick box near the “Download” button, 

on the right hand panel of the laser machine software window on your 

PC. 

 

Step 7. Cut 

Press the “Download” button in the PC laser software window to open the 

download options window. This will allow you to download the file to your 

laser machine. In this window, click “Download Current”. 

 

When the file has been downloaded to your laser machine, press “Start” 

on either your laser machine or the laser software to start the laser 

machine running the job. 

 

1.2. How to Engrave with a Laser Machine 

Step 1. The Software 

Open the laser software provided with your machine.  

This software will have been installed onto your computer by a trained 

CTR technician when your laser machine was delivered and installed. 

 

Step 2. The Laser Machine 

If you have a fume filtration system, make sure this system is connected 

to your laser machine and fully set up. 

 

Switch on the laser machine and water cooler unit. 

 

Switch on the fume filtration system. 
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Step 3. Focus the Lens 

Place the material you want to work with flat on the laser machine bed. 

Focus the laser machine lens - focus instructions are available on the 

software disc provided with your laser machine, in the “Settings” folder 

(please see the “Adjusting the Lens Focus Height” article). 

WARNING: Ensure that the bed is at the correct height that the laser 

machine lens barrel can easily clear the highest point of the material. 

Failure to do this may result in damage to the laser machine or materials 

being worked on. 

 

Step 4. Creating the Engraving File 

Open or create a file to be engraved - if you are running a first test, you 

could try drawing a box, with a smaller circle inside it, to cut.  

 

If you are importing a file to be engraved, we recommend you use BMP 

file format for scanned images and photographs, or DXF for engraving 

solid shapes (circles, squares, text etc). 

 

Step 5. Settings 

You can select individual shapes and click on a different colour from the 

colour panel on the right of the software screen to put the graphics on 

different layers. This means you can set a different speed and power for 

each different layer (for each coloured graphic). 

 

In the top right of the software screen, each colour actively being used in 

the software will be shown in a list. Click on the drop-down menu for each 

coloured row to set these items to Engrave.  

 

Double click on the settings for each coloured row to set the speed and 

power parameter settings, according to the type and thickness of material 

which you are using. 

NOTE: the laser software will run the graphics according to the order of 

this colour list, the top colour first, working down to the last colour in the 

list. 

 

Step 6. Set the Origin for the Laser Head 

If “Immediate” is ticked: the laser machine will engrave the graphics 

starting from the current location of the laser machine head. 

Use the arrow keys on the laser machine control panel to move the laser 

head into the desired position. You must ensure that the laser machine 

has enough room to engrave the file which you want to run, and also 

make sure that the file is not too big for the piece of material being used. 

You can test this by pressing the “Outline” button on your laser software. 
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If “Immediate” is not ticked: the laser machine will engrave the graphics in 

the location that they are placed on the laser machine software window.  

 

NOTE: you can find the “Immediate” tick box near the “Download” button, 

on the right hand panel of the laser machine software window on your 

PC. 

 

Step 7. Cut 

Press the “Download” button in the PC laser software window to open the 

download options window. This will allow you to download the file to your 

laser machine. In this window, click “Download Current”. 

 

When the file has been downloaded to your laser machine, press “Start” 

on either your laser machine or the laser software to start the laser 

machine running the job. 

 

1.3. How to Score / Mark Lines with a Laser 

To score a line which does not cut all the way through the material, use 

the same instructions as 1.1 How to Cut with a Laser Machine, simply 

changing the laser cutting power to a lower setting. Decreasing the laser 

power means the laser beam will not cut all the way through the material.  

 

Increasing the laser speed setting means the laser beam will not cut 

through the material as deeply as at a slower speed.  

 

1.4. How to Cut and Engrave in the same Job 

Step 1. The Software 

Open the laser software provided with your machine.  

This software will have been installed onto your computer by a trained 

CTR technician when your laser machine was delivered and installed. 

 

Step 2. The Laser Machine 

If you have a fume filtration system, make sure this system is connected 

to your laser machine and fully set up. 

 

Switch on the laser machine and water cooler unit. 

 

Switch on the fume filtration system. 

 

Step 3. Focus the Lens 

Place the material you want to work with flat on the laser machine bed. 

Focus the laser machine lens - focus instructions are available on the 
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software disc provided with your laser machine, in the “Settings” folder 

(please see the “Adjusting the Lens Focus Height” article). 

WARNING: Ensure that the bed is at the correct height that the laser 

machine lens barrel can easily clear the highest point of the material. 

Failure to do this may result in damage to the laser machine or materials 

being worked on. 

 

Step 4. Creating the File 

Open or create a file to be both cut and engraved.  

 

When importing a file to be cut, we recommend you use DXF file format. 

Please note that only vector lines can be cut. 

 

When importing a file to be engraved, we recommend you use BMP file 

format for scanned images and photographs, or DXF for engraving solid 

shapes (circles, squares, text etc). 

 

Step 5. Settings 

You can select individual shapes and click on a different colour from the 

colour panel on the right of the software screen to put the graphics on 

different layers. This means you can set a different speed and power for 

each different layer (for each coloured graphic). 

NOTE: the cut graphics and the engraved graphics must be on separate 

layers (set as different colours). 

 

In the top right of the software screen, each colour actively being used in 

the software will be shown in a list. Click on the drop-down menu for each 

coloured row to set these items to Cut or Engrave respectively.  

 

Double click on the settings for each coloured row to set the speed and 

power parameter settings, according to the type and thickness of material 

which you are using. 

NOTE: the laser software will run the graphics according to the order of 

this colour list, the top colour first, working down to the last colour in the 

list. 

 

Step 6. Set the Origin for the Laser Head 

If “Immediate” is ticked: the laser machine will run the graphics starting 

from the current location of the laser machine head. 

Use the arrow keys on the laser machine control panel to move the laser 

head into the desired position. You must ensure that the laser machine 

has enough room to engrave the file which you want to run, and also 

make sure that the file is not too big for the piece of material being used. 

You can test this by pressing the “Outline” button on your laser software. 
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If “Immediate” is not ticked: the laser machine will run the graphics in the 

location that they are placed on the laser machine software window.  

 

NOTE: you can find the “Immediate” tick box near the “Download” button, 

on the right hand panel of the laser machine software window on your 

PC. 

 

Step 7. Run the Job 

Press the “Download” button in the PC laser software window to open the 

download options window. This will allow you to download the file to your 

laser machine. In this window, click “Download Current”. 

 

When the file has been downloaded to your laser machine, press “Start” 

on either your laser machine or the laser software to start the laser 

machine running the job. 

 

1.5. How to Create an AI file 

When cutting, we suggested you use either AI or DXF files (see 1.6 How 

to Create a DXF file). When creating an AI file from CorelDraw or similar 

software, use the following settings: 

 
The AI file can then be imported into the laser software.  
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1.6. How to Create a DXF file 

When cutting, we suggested you use either AI or DXF files (see 1.5 How 

to Create an AI file). When creating an AI file from CorelDraw or similar 

software, use the following settings: 

 
The DXF file can then be imported into the laser software. 

1.7. FAQ 

1.7.1. The graphics won’t engrave 

Ensure that the graphics are closed, as the software will only engrave 

vector shapes which are fully enclosed. Highlight the graphics, then go to 

“Tools > Join Lines”. 

1.7.2. When engraving, the edge is not straight 

This is caused by the scan gap (“Y step mm”) – the distance between 

each engraved line of the laser machine. To check if the scan gap is 

causing a problem, draw a rectangle in the Easycut software, and set the 

mode to “Engrave”.  

Double-click on the layer the rectangle is on (in the laser output interface 

shown below), to open the Set Engrave Options window. 
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This window displays the scan gap, and the option of bi-directional or 

single direction engraving. Set the parameters as follows: 

  
Generally, the odd and even rows will be slightly staggered, as shown 

below. 

 
Measure the gap between the odd and even rows, then input this number 

in the Backlash setting of the Engrave Options window (File > Machine 

Options > Work mode > Engrave > [select the first line in the table, 

beginning 0.00] > Modify). 
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The most accurate engraving method is to engrave in a single direction, 

rather than Bi-dir (Bi-directional). However, this will increase the job time.  
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Section 2: EasyCut Software Index 
The EasyCut laser software interface is displayed as follows. 

 
 

2.1. FILE 

2.1.1. New 

 “New” creates a new, blank file in the work area. 

2.1.2. Open 

 “Open” allows you to load processed data made (previously saved) 

in the laser software. The laser software file format is an ECP-EC Project 

File (﹡.ecp). 

2.1.3. Save 

 “Save” allows you to save the current graphics and processing 

parameters as an ECP-EC Project File (﹡.ecp). 

2.1.4. Save As 

“Save As” allows you to save an ECP-EC Project File (﹡.ecp) under a 

different name. 

NOTE: the file type will stay the same (ECP-EC Project File). 

2.1.5. Import 

 “Import” allows you to load/open data into the laser software 

window.  
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NOTE: only file types which are supported by the software can be 

imported. The software accepts the following file formats: 

*.PLT 

*.AI 

*.DXF 

*.DST 

*.BMP 

*.NC 

*.JPG and *.JPEG 

*.GIF 

*.PNG 

*.TIF and *.TIFF 

*.TGA 

*.PCX 

2.1.6. Export 

“Export” saves the graphics data shown on screen in the current window 

as either a standard PLT/HPGL file (*.PLT) or a DXF (*.DXF) file. You can 

also specify a different file name if required. 

2.1.7. Machine Options 

Click this button to display the interface as follows. 

 
WARNING: Any alterations to these parameters will change the 

performance of the machine. Before changing the parameter, you 

should consult your supplier. 

2.1.8. Print 

Opens the “Print” window to enable you to print a copy of the graphics 
shown on screen. Enter your printer settings as normal, depending on 
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your printer type. 

2.1.9. Print preview 

Allows you to view on screen the image which will be printed. 

2.1.10. Print Setup 

Opens the “Print Setup” window to allow you to change any of the 
printer settings as required before printing the graphics displayed on the 
screen. 

2.1.11. Exit 

Click “Exit” to close the software on your computer. 

 

2.2. EDIT 

2.2.1. Undo 

 Click the “Undo” icon to remove the last action made in the software 

(step back one move). 

2.2.2. Redo 

 Click the “Re-do” icon to repeat the action previously undone in the 

software (step forward one move). 

2.2.3. Refresh 

 Click this button to update the screen. 

2.2.4. Pick  

 This icon allows you to select graphics on the laser software screen. 

One or more graphics can be selected at the same time. Only whole 

graphics can be selected (e.g. an entire line. You cannot use this option 

to select one part of a whole line). 

Graphics which have been selected will be indicated by the highlight box 

surrounding the outer edge of the graphics, and any vector lines will turn 

red. 

 

You can also do the following: 

Click the “Pick” icon, and select the graphics you wish to alter. 
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Move the mouse to one of the black squares in the highlight box 

surrounding the outer limit of the graphics. Click and drag the highlight 

box to re-size the graphics. 

NOTE: holding the “Ctrl” key on your keyboard while re-sizing the 

graphics using any of the four corner highlight boxes will scale the 

graphics. 

 

You can also do the following: 

After you select the graphics, press the spacebar on your computer 

keyboard to display the following window. 

 
You can use the Position (XY) coordinates to change the position of the 

graphics, or select one of the Local data positions to move the location of 

the graphics on the work area. 

The Array section allows you to create multiples of the graphic in either 

columns or rows, and specify a space (Offset) between each of the 

graphics as required. 

NOTE: the “Array” options will only be available if no more than one 

vector graphic is selected. 
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2.2.5. Zoom in  

 Click this icon to increase the magnification of the shown work area. 

This can be done either by clicking on a point on the screen to increase 

the magnification, or by clicking and dragging a box around the area you 

want to see magnified.  

2.2.6. Zoom out  

 Click this icon to decrease the magnification of the shown work area 

on the screen. 

2.2.7. Pan  

 “Pan” allows you to move the position of the screen currently shown. 

Click and drag the left button of your mouse to move the screen area 

currently displayed. 

2.2.8. Zoom to table  

 Show the entire processing (work) area on the computer screen. 

2.2.9. Zoom to all object  

 Show all of the graphics on the computer screen. 

2.2.10. Center to table  

Click “Edit” > “Center to Table”. When the graphics are created or 

imported, it may be outside of the laser machine work area. This option 

will move the graphics into the centre of the machine work area.  

 

2.3. DRAW 

2.3.1. Line 

 Click this button, then click the mouse once on the screen to position 

the start of a straight line, and a second time to position the end.  

HINT: Hold down the “Ctrl” key on your keyboard when moving mouse to 

position the end of the line to draw horizontal or vertical lines. 

2.3.2. Rectangle 

 Click this button, then click the mouse once on the screen to position 

the start of a rectangle, and again to position the end.  

HINT: Hold down the “Ctrl” key on your keyboard when positioning the 

end point to draw a square. 

2.3.3. Polyline 

 Click this button, then click the mouse once on the screen to position 
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the start of a line. Click the mouse as many times as required in different 

positions to create anchor points for the line. To finish the line, either 

double click the mouse, or press enter on your keyboard. 

HINTS: Press “C” on your keyboard to close the line.  

Hold the “Ctrl” key on your keyboard to draw horizontal or vertical lines. 

2.3.4. Ellipse 

 Click this button, then click the mouse once on the screen to position 

the start of an ellipse, and again to position the end.  

HINT: Hold down the “Ctrl” key on your keyboard when positioning the 

end point to draw a circle. 

2.3.5. Bezier  

Go to “Draw” > “Bezier”. Press and hold the mouse button to drag a 

straight line to specify the start point of the Bezier line, and the direction 

you want the curve to go. Release the mouse button, then double click to 

position the end of the curved Bezier line.  

2.3.6. Text  

 Click this button, then click and drag a box in the work area of the 

laser software screen to open the Text Edit window: 

 
Enter letters and/or numbers into the “Text” section of this window, and 

set the parameters as required (font type, size, spacing between letters). 

2.3.7. Change Text to curve 

This option will convert any selected text into curves. 

HINT: text typed directly in the laser software using the “Text” tool will be 

automatically dropped to curves when it has been created. 
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2.3.8. Copies  

 This option allows you to create multiple copies of a graphic.  

Use the “Pick” icon  to select the graphics you want to duplicate so 

that they are indicated by the highlight box. Click the “Copies” button to 

open the Array Copy Options window: 

 
Enter the required parameters (the number of duplicates in rows or 

columns, and the distance between each duplicate graphic), then press 

OK.  

HINT: Rows and Columns cannot have an entry of less than 1, as this 

number indicates the original graphic. Entering “2” will create a second 

copy of the graphic. 

2.3.9. Rotate 

 Click the “Pick” icon  and select the graphics you want to rotate. 

Click the “Rotate” icon to open the Rotate Options window: 

 
Input the number of degrees you want to rotate the graphics (the rotation 

is in a counter clockwise direction). 

If you want to manually rotate the graphics, press Cancel when the 

Rotate Options window opens, and you can rotate the graphics by 

clicking and dragging the mouse anywhere on the screen.  

HINT: to accurately rotate the graphics manually, it is best to click and 

drag the mouse as far away from the graphics as possible, so that the 

margin for error is smaller (close to the graphics, a small movement will 

rotate the graphics further then rotating the graphics from the other side 

of the screen). 
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2.3.10. Mirror (vertically) 

 Click the “Pick” icon  and select the graphics you want to edit. 

Then click the Mirror (vertically) button. The graphics will be mirrored 

vertically in position.  

See below for an example. The blue upper are the original graphic, and 

the red lower is the mirrored graphic. 

 

2.3.11. Mirror (horizontally) 

 Click the “Pick” icon  and select the graphics you want to edit. 

Then click the Mirror (horizontally) button. The graphics will be mirrored 

horizontally in position. 

See below for an example. The blue upper are the original graphic, and 

the red lower is the mirrored graphic. 

 

2.3.12. Size  

 This icon allows you to accurately change the size of the graphics. 

Click the “Pick” icon  and select the graphics you want to edit. Click 

the “Size” icon to open the “Scale options” window. 

 
Input the new length for the X and/or Y-axis as required. Click “OK” to 

apply these settings.  

HINT: To keep the graphics in proportion (scale the graphics instead of 
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re-sizing them) enter a new length into either the X or Y-axis. Click the 

 button for the other length, and this dimension will be automatically 

calculated. 

2.3.13. Align  

There are 7 options for aligning: 

  

Align left. 

Align right. 

Align top. 

Align bottom. 

Align centre (vertically). 

Align centre (horizontally). 

Align centre (absolute centre).  

HINT: the graphic selected last will be the point of reference for the 

alignment. 

2.3.14. Edit node 

 Click this icon to display the nodes of a selected vector graphic. The 

nodes are shown as small yellow boxes: 

 
Click once on a node to lift it, and a second time to position the node in a 

new location.  

Double-click on a vector line to add a node in that location.  

Click and drag a box around one or more nodes, then press the “Delete” 

key on your keyboard to delete the selected nodes. 

2.3.15. Split line 

Select this option from the “Draw” menu, then single-click anywhere on a 

vector (line) graphic to create a break in the line. A node will be added (as 

shown by a yellow box). The graphic will then treat the divided line as two 

separate graphics, which can be edited individually (e.g. move one line to 

a new location).  

TIP: if you are splitting a graphic such as a rectangle, the divide will be 

created from the node currently displayed on the rectangle, to the point 

where you click. So one click will split the rectangle into two lines (you 
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cannot set a start and end point). 

 

2.4. TOOLS  

2.4.1. Check Data 

Go to “Tools” > “Check Data” to open the “Check data options window”. 

This window can be used to check if there are specific problems with the 

vector graphics on screen. 

 
Tick the boxes for the checks you wish to run, and press “Check”. 

HINT: If the bottom bar displays “Check result:0”, there are no faults. 

“Check result:1” or higher tells you how many faults the check has found. 

The graphics with the fault will be highlighted on your computer screen in 

red.  

Check closed: use this option to check if vector graphics are fully 

enclosed for engraving. Vectors can only be engraved when fully 

enclosed.  

Check self-intersect: use this option to check if any part of a graphic 

overlaps itself. For example, a Bezier line which goes back on itself would 

be highlighted in red, with the overlapping lines highlighted in thick blue 

as shown below. 

 
Check intersect: use this option to check if any of the vector lines are 
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overlapping.  

2.4.2. Smooth curve 

 This tool can smooth curves to improve the cutting speed. Click the 

“Pick” button and highlight the vector graphics you want to edit. Click the 

“Smooth curve” button to open the following window. 

 
Select from one of the three options. The levels increase in smoothness. 

NOTE: “Three Level” is the smoothest, but has the largest distortion. 

2.4.3. Join lines 

“Draw” > “Join Lines” allows you to unite lines which are intersecting or 

close to each other, to join them into one line. This is usually used for 

DXF files, or vector graphics drawn directly in the software. 

 

This open will open the “Join lines options” window, where you can 

specify the maximum size of gap between the lines. If you set the “Gap 

tolerance” as 1.0, then all lines which have ends closer than this distance 

will join together, while lines further away will not be joined. 

2.4.4. Offset curve  

 This option allows you to create a contour of the selected graphics.  

Click the “Pick” button and select the graphics you want to contour. This 

will enable to offset curve button.  

Click this button to display the following options window. 

NOTE: the newly created line will be displayed in green, and can be 

treated as an independent line (you can edit the original graphics without 

it effecting the offset curve line/shape). 

An example of the word “LASER” is shown below, where the original 

graphics are red, and the offset curve contour line is shown surrounding 

the original letters.  
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.Corner Type: allows you to select whether the corner shape will be 

curved (“Arc”) or straight points (“Line”).  

HINT: you cannot “Arc” when contouring a straight line. If you have a 

shape such as a triangle and you select to create a contour inside of this, 

the corners cannot arc.  

Distance: specify the distance you want the new line/shape to be from 

the original. 

OPTIONAL SETTINGS 

Outer: create the new line/shape on the outside of the original graphics. 

Inner: create the new line/shape on the inside of the original graphics. 

Auto: the computer will automatically choose whether the shape should 

have a contour created outside or inside of the original. 

Double Outer: creates a contour line/shape on both the outside and 

inside of the original graphics. 

 
2.4.5. Output order 

This option allows you to set the sequence which the work will be lasered. 

Click “Tools” > “Output order” to open the adjust output order window. 
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Each ID number represents a separate graphic.  

To change the laser sequence listed, use the arrow buttons to move the 

ID numbers into the right hand column as shown above. You can then 

use the “Up”, “Down” etc. buttons to change the order as required.  

HINT: you will only be able to view one vector layer (shown by the colour 

of graphic) at a time. Use the “Layer” drop-down menu to change the 

layer you are looking at. 

2.4.6. Invert colours 

 This is only for BMP.  Click “pick” button , and choose the 

graphics you want to edit. Then click this button, the black part will be 

changed to white and white to black. The following is the sample. 

 
 

2.5. LASER 

2.5.1. Define cut route 

 This software will define the starting point and direction automatically. 

Generally, the point is on the corner. When you need to change the 

starting point and direction, you can click this button, and then move 

mouse to the graphics. The mouse will change to be a crisscross. Now 

click the left key of mouse on any point of the graphics, and this point will 

be the new starting point. You can change the direction by clicking “F” 
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key. The following is a sample. 

 
 

Click “Spacebar” and you can set lead in/out line. 

 
Calculate: select this option and you can set lead in/out lines. 

Entry/Exit type: type of lead in/out lines. There are 2 types: arc and line. 

Arc radius: radius of lead in/out arc. 

Line length: length of lead in/out lines. 

Line angle: angle of lead in/out lines. 

: set the exit parameters as same as that of entry. 

Auto set direction: this software will set where the lead in /out lines are (in 

or out of the graphics outline) automatically. 

Manual set direction: set where the lead in /out lines are. 

Over lap/leave space: this option determines whether the processing 

effect is closed. The length of over lap (or leave space) is set by the input 

number beside this option. 
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2.5.2. Set Laser Origin  

 Click this button. 

 
You can set origin point anywhere as you prefer. 

2.5.3. Array output options 

 Click this button. 

 
Cell Width(X/Y): It is the original size of the data. 

Times: It is the number of rows and columns you need. 

Gap: It is the space between two adjacent rows or columns. 
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Width: It is the width of whole data. 

Height: It is the height of whole data. 

Gap along Y: It is the space along Y axis between the first and second 

column. 

Gap along X: It is the space along X axis between the first and second 

row. 

Array-data Only Draw Box: If you select this option, there will be only 

one data on screen; others will be shown as rectangles. 

Auto-cover Calculation: This can calculate the number of row and 

column that can cover the whole material according to the parameter you 

input. Click this button, 

 
Material width(X): It is the width of the work piece (the default is the 

worktable’s width). 

Material height(Y): It is the height of the work piece (the default is the 

worktable’s height). 

The following is a sample. 

 
2.5.4. Calculate  

When the graph and processing parameters are changed, this button 

should be clicked to save the processing parameters in processing file. 

2.5.5. Clear log  

Click this button; the system will clear the log. 
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2.5.6. Simulate 

 When parameters set is finished, please click this button. It can 

simulate the procedure of output for checking the result of output. 

Click “Esc” on the keyboard and you can cancel the simulation process. 

 

2.6. VIEW  

2.6.1. Toolbar 

File toolbar: Click this button, you can display or hide the following bar, 

located at the top of the screen. 

 
Output toolbar: Click this button, you can display or hide the following 

bar, located at the top of the screen. 

 
Edit toolbar: Click this button, you can display or hide the following bar, 

located on the left of the screen. 

 
Layers toolbar: Click this button, you can display or hide the following 

bar, at the bottom of the screen. 

 

Use the “Pick” button  to select a graphic on screen, then click any of 

the color icons shown in this toolbar to change the vector lines to this 

colour. This method allows you to create a new layer in the layer list, as 

each colour represents a different layer. For imported images, the outline 

colour will change and indicate the layer the image is on. 

Align toolbar: Click this button, you can display or hide the following bar, 

on the left of the screen. 

 

2.6.2. Status Bar 

Click this button to show or hide the status bar, shown here. 

 
The status bar shows the mouse coordinates. 
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2.7. HELP 

2.7.1. Help 

Click this button, and you can see the manual of the software. You can 

get any information about how to operate the software. 

2.7.2. About 

Click this button to display the following window, showing the laser 

software name and version, and supplier contact information. 
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Section 3: Laser Output Options 

3.1. Laser Output Interface Panel 

The laser output interface in the laser software on your PC is divided into 

three sections:  

LAYER

TEST / AUXILIARY
PROCESSING
PARAMETERS

DOWNLOAD

 

3.1.1. Layer 

3.1.1.1. Layer: Main Interface 

Every separate graphic can be set to a different layer, as required.  

You can specify layers through selecting the graphic, and clicking a 
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colour from the pallet available at the bottom of the screen. The graphic 

will then change to the colour selected (note that if the graphics is an 

image file rather than a vector, only the outline will display the layer 

colour).  

When a layer colour is in use on the screen, it will be displayed in the 

layers interface, as shown below. 

 
Layer: displays the colour of the layer. 

Mode: can be set to Cut, Engrave, Grade Engrave or Hole. For more 

details, see the sections “Set Cut/Engrave/Grade Engrave/Hole Options”. 

Speed: sets the speed the laser machine will run at, for this layer. 

Power: sets the power the laser machine will run at, for this layer. This 

number is a percentage of your total laser power.  

i.e. an 80W laser machine running at 50% power will cut with 40W of 

power when running the job.  

Output: if this option is ticked, the layer will be included when the job is 

downloaded to the laser machine. If this option is not ticked, the layer will 

not be processed by the laser machine. 

Times: default is 1. This shows the number of times this layer will be 

processed.  

3.1.1.1.1. Changing the Order of Layers 

If you have more than one layer, the laser machine will process the 

sequence from the top to bottom according to the list in the layers 

interface.  

To change the order of the list (and subsequently the processing order), 

select one of the layers (the entire row will be highlighted). Press the “Up” 

or “Down” buttons to move the highlighted row up or down in order.  

3.1.1.1.2. Layer Properties 

You can specify different properties for each individual layer. For more 

details, see the sections “Set Cut/Engrave/Grade Engrave/Hole Options”. 

When there are more than one layer, you can change all of the layers to 

the same properties by selecting the row with the required properties, 

then pressing “All”. 



CTR Laser Machine Operator Manual ( EasyCut version 5.3 ) ~ version 1.0 34

3.1.1.2. Set Cut Options 

To edit the settings of a layer, click on the down arrow next to the “Mode” 

for that layer. Select the option you want from the drop-down list: e.g. Cut. 

Double-click the colour bar in the “Layer” column to view the following 

options window.  

 
Speed: vector cutting speed on X-Y axis. 

Power: the laser power when the layer is processed. 

Corner Power: the laser power when laser head runs on corners.  

When the laser head fires on corners, the speed will slow down. If the 

power is kept constant, the corners will be cut deeper than the rest of the 

cuts. 

Overlap: this number specifies the distance that the laser will overlap the 

end of a vector graphic. If you are cutting a shape, a small value may be 

required here to ensure your graphics are fully cut out, and not held in by 

a thin tab.  

Not Blow: air assist will not blow. CTR strongly recommend you do not 

use this option.  

Blow with Laser: air assist will blow while the laser fires, and stop when 

the laser is not firing. This function requires hardware support. 

Always Blow: air assist will blow for the entire duration of the job, and 

stop when the job is complete. This option is the default setting, and 

recommended for normal use. 

: open the advanced layer options window. 
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Laser: This is the PWM frequency. 

Original: The machine draws the graphics according the route 

automatically set by the software. 

Optimize: The software will calculate the best route to improve the 

processing efficiency. If you select this option, there are 2 options. 

Inner-to-outer: cut from inner to outer shapes. 

Down-up: cut from bottom to top according the specified “divide-height”. 

Automation set cut direction: The software will automatically select the 

cut direction. To change the default direction, de-select this option.  

Power2, Corner power2: only applicable if there are two laser heads. 

This needs hardware support. 

Delay before laser on: delay before laser on. 

Delay after laser on: delay after laser on. 

Delay before laser off: delay before laser off. 

Delay after laser off: delay after laser off. 

3.1.1.3. Set Engrave Options 

To edit the settings of a layer, click on the down arrow next to the “Mode” 

for that layer. Select the option you want from the drop-down list: e.g. 

Engrave. 

Double-click the colour bar in the “Layer” column to view the following 

options window.  

 
Speed: engraving speed on X-axis. 
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Power: the laser power when a layer is processed. 

Scan gap: movement distance on Y-axis when engraving a row on 

X-axis (the distance between each line of engraving). 

Bi-dir: the laser can engrave in either one direction (left to right, not firing 

right to left), or two directions (engrave left to right, and right to left). 

When “Bi-dir” is ticked, the laser will engrave in both directions.  

Blow: blow or not. This function needs hardware support. 

: open the advanced layer options window. 

 
Fill circle: select this option, and small circles will fill in the graphics 

(below right “S” example). 

Engrave circle: this option determines whether the circle or background 

will be engraved. 

Radius: radius (size) of the circle. 

Space: distance between each circle. 

Power2: laser power of the second laser head. This needs hardware 

support.  

 
 

3.1.1.4. Set Grade Engrave Options 

The dimensions of grade engrave are as follows.  
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To edit the settings of a layer, click on the down arrow next to the “Mode” 

for that layer. Select the option you want from the drop-down list: e.g. 

Grade Engrave. 

Double-click the colour bar in the “Layer” column to view the following 

options window.  

 
Speed: engraving speed on X-axis. 

Scan gap: movement distance on Y-axis when engraving a row on 

X-axis (the distance between each line of engraving). 

Power: the laser power when a layer is processed. NOTE: This 

parameter determines the depth of the slope. 

Min-Power: the lowest laser power when grade engraving. 

Grade-width: the width of grade. 

Bi-dir: the laser can engrave in either one direction (left to right, not firing 

right to left), or two directions (engrave left to right, and right to left). 

When “Bi-dir” is ticked, the laser will engrave in both directions.  

Blow: blow or not. This function needs hardware support. 

Repair: select this option to make engraved letters clearer. 

3.1.1.5. Set Hole Options 

To edit the settings of a layer, click on the down arrow next to the “Mode” 

for that layer. Select the option you want from the drop-down list: e.g. 

Hole. 

Double-click the colour bar in the “Layer” column to view the following 

options window.  
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Power: the laser power when a layer is processed. 

Interval: the space between two adjacent holes. 

Radiation time: determines the size of holes. 

Blow: blow or not. This function needs hardware support. 

: open the advanced layer options window. 

 
Power2: laser power of the second laser head. This needs hardware 

support. 

NOTE: All the defaults are the last saved parameters. 

3.1.2. Test / Auxiliary Processing Parameters 

 

， ， ， ， ， : These buttons move the X, 

Y and Z axis (where there is a motorized Z axis). 

 , : Moves the laser head to the home position of the 

machine, and then to the origin point, as when the laser machine first 

starts up.  

Slow, Step, Length: Not in use for laser machines. 
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: Laser on/off. This button will fire the laser for the duration for 

which it is held.  

 

PROCESSING 

In the following dialog box, some auxiliary processing parameters can be 

set. 

 
Times: the number of time the graphics which are downloaded to the 

laser will be run. The default is 1. 

Delay: the delay (in seconds) between each repeat (“Times”) of the 

graphics being run.  

EXAMPLE: 

Times: 10 

Delay: 20 

The above settings will repeat the graphics 10 times, with a delay of 20 

seconds between each repeat.  

Immediate: If this option is selected (a tick in the box), the software will 

take the current position of the laser head as the point at which to start 

cutting/engraving your job.  

If this option is not selected (no tick in the box), the graphics will be 

cut/engraved according to their position on the software screen on your 

computer. 

: Click this button for the laser head to move in a rectangle 

outlining the total size of the graphics. The laser will not fire during this 

movement. 

: Click this button for the laser head to cut a rectangle, outlining 

the total size of the graphics. The laser will fire during this movement. The 

following window will be displayed for you to set the cutting speed and 

power for the outline. 

 
Speed: the speed the laser head will move at when cutting the outline 
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box. 

Power: the laser power when cutting the outline box. 

Blank: the distance between the processing graphics and the outline 

box. 

Save: save these parameters for the next outline you run. 

: opens the advanced layer options window. The advanced options 

require hardware support.  

 
 

3.1.3. Download Data 

 

3.1.4. Download CFG 

Download the configuration file to the laser machine. This will only be 

needed if the software is re-installed on a new computer, or if you edit the 

“Options” parameters, or update the firmware.  

3.1.5. Download Current File 

Download the current processing data to the laser machine controller. 

Every time you create a new file for laser cutting/engraving, you will need 

to press this button to download the job to the laser machine ready for 

running. 
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3.1.6. Download File  

Download a data file to the laser machine controller. 

3.1.7. Del  

Delete the selected file.  

3.1.8. Del All  

Delete all the files stored in the laser machine. 

3.1.9. Export Cfg  

This will create a *.mol file which includes all the specified “Options”. 

3.1.10. Export File 

This will create a *.mol file which includes all the parameters of the 

processing data.  
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Section 4: PAD03 Operation 

4.1. PAD03 Main Interface 

 
Datum: Laser head will move to the origin point of the machine.    

Laser: Will pulse fire the laser when pressed. Will continuously fire the 

laser when held down, until released. 

Stop: Cease the processing operation. 

Test: The laser head will trace a box around the outline border of the job. 

The laser beam does not fire during this process. 

Start/Pause: Start/pause the processing operation. 

Esc: Exit the current status window on the control panel. 

Menu: Enter accessory interface. 

: Click this button, press Datum to move the bed to the origin. Then 

press either    or    to move the Z axis. This function needs hardware 

(machine) support. 

: Enter. 

 

4.1.1. Startup Interface 

When the power is turned on, the PAD will display ”System starting, 

please wait”. Then, depending on your machine setup, the PAD should 

display “Datum” as the X/Y axis move to the home position. 
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4.1.2. Main Interface 

The main interface displays as follows. 

 

 

 

 

 

 

File: Displays the file names which are saved in the MPC controller. 

Speed: Controls the speed, as a percentage, relative to the original 

speed which the operator has set in the software.  

When the percentage is set to 100%, the actual speed is the number 

which is set in processing data. 

CTR recommend you leave this setting at 100%. 

Power: Controls the power, as a percentage, relative to the original 

power which the operator has set in the software.  

There are two options: the former is for “Corner-Power” and the latter for 

“Power”. 

CTR recommend you leave this setting at 100 / 100%. 

Del: Delete the current file. 

 

4.1.3. Main Interface: Navigation 

Originally, the file name is highlighted (white text and black background).  

Press     and     , and you can select the option you want to modify. 

Press     and     , and you can change the number/file in the selected 

option. 

Press  and all the number will be saved. 

Press “Esc” and any alterations you have made will not be saved. 

NOTE: With any options on the display menu highlighted, the arrow keys 

navigate the menu. 

By pressing “Esc” so that nothing is highlighted, pressing                 

will move the laser head.  

Press  again to modify the options (file name is highlighted). 

FILE   

SPEED  100％ 

POWER 100 / 100％ 

PIECES   1  DEL 

AAA 
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4.2.4.2.4.2.4.2.    PAD03 Processing Interface    

Press “Start” and the interface will show as following. 

 

 

 

 

 

File: File name which is being processed. 

Speed: Percentage of speed.  

Power: Percentage of power.  

Time: Time for processing this file. 

 

When processing… 

Press     and     , and you can change the percentage of power (only 

for Power, not for Corner-Power). 

Press     and     , and you can change the percentage of speed. 

Press “Start/Pause” and you can control the processing procedure. 

Press “Stop” and you can cancel the entire processing procedure. The 

interface shows “Stopped”. Press “Esc” and you can see the main 

interface. If you do this, you will not be able to resume the job other than 

from the very beginning. 

 

4.3.4.3.4.3.4.3.    PAD03 Accessory Interface    

Press “Menu” and you can see the accessory interface. 

 

 

 

 

 

CUT BDR: Laser head will move a rectangle with laser on according to 

the size of the graphics. 

LAS SET: Select this option and press .  

The LAS SET interface is as following. 

 

 

 

 

 

 

  

Press     or     can move the cursor. 

FILE  AAA 

SPEED  100％ 

POWER 100 / 100％ 

TIME  0 ：0 ：15 

  

LAS  SET  

PMOV  SET 

LANGUAGE 

CUT   BDR 

LASER TIME SET 

         MS 

POWER SET 

          % 

00000

00000
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Press    or    can change the number. 

 

Press  and all the number will be saved. 

If the time is set to “0”, pressing the “Laser” key will turn the laser on; 

releasing the “Laser” key will turn the laser off. 

If the time is not set to “0”, the laser will fire for the time period 

displayed.  

PMOV SET: Select this option and press .  

The PMOV SET interface is as following. 

 

 

 

 

 

 

Press    or    can change the number. 

Press  and all the number will be saved. 

If this number is set to “0”, press the direction keys, and the laser head 

will move; release the direction keys, and the laser head will stop. 

If this number is not set to “0”, press the direction keys, and the laser 

head will move a distance as you set. 

LANGUAGE: Select this option and press .  

The language interface is as following. 

 

 

 

 

 

Select the language as required. 

 

 

DISTANCE SET 

         MM 

 

简体中文 

繁体中文 

ENGLISH 

00000
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Section 5: Troubleshooting 

 

5.1. Troubleshooting Menu 

 

5.1.1. No power to the machine at all. 

a. The power key switch is not turned. 

b. The fuse under the power input connector has blown 

c. The Emergency stop switch has been pressed. 

 

5.1.2. The laser will not fire. 

a. The water cooler is turned on and there is no alarm sounding. 

(Alarm will sound if a hose is crimped or there is a restriction in the 

flow of water, also if the water cooler has gone over temperature). 

The water should be replaced every 6 to 8 months. You can empty 

the existing water via the drain cap at the rear of the cooler. Once 

empty replace cap and then fill with de-mineralised or distilled water. 

Not de-ionised or tap water. Fill from top cap until you can touch the 

top of the water by dipping your finger in. (On systems with water 

cooler interlock, should the water cooler alarm up, a message will 

appear on the machine display and you will hear a beeping noise. 

Press ESC to reset). 

b. The Laser Enable switch on the front of the machine is switched on. 

c. The Lid is not closed fully. (It is possible that there is a fault with the 

lid interlock micro-switches. To test this keep the lid closed and 

CONTENTS 

5.1.1. No Power to the machine at all. 

5.1.2. The laser will not fire. 

5.1.3. The machine is producing staggered start points on engraving. 

5.1.4. The machine is not cutting through the material. 

5.1.5. The software will not download to the machine. 

5.1.6. Not all users on the network can access the Easycut program. 

5.1.7. Files will not import to Easycut. 

5.1.8. The file imports but the laser does not cut or engrave parts. 

5.1.9. My machine only cuts in the top left corner. 

5.1.10. Soft stop comes up on the display when trying to run a job. 

5.1.11. I have downloaded a revision but machine runs previous job.  

5.1.12. My laser power seems low. 
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insert the lid over-ride key. Turn and then tap Laser and see if the 

machine will fire.) 

d. On machines with optional red dot ensure dot is in off position to 

allow laser to fire. 

 

 

 

 

 

5.1.3. The machine is producing staggered start points on engraving. 

a. The Lens in the barrel is loose. This would cause the lens to move 
from side to side as the machine rasters the image. Loosen the 
thumb screw on the side of the barrel and drop the barrel out. 
Then unscrew the barrel from the nozzle and you will see the lens 
held in by a threaded collar. You can shake it by your ear to see if 
there is a rattle. Should the lens need tightening first make sure 
the lens is sitting properly in its recess. Then place a pair of needle 
nose pliers in the 2 slots on the collar and turn to tighten. Keep 
outwards pressure so as not to slip and damage the lens (CTR 
recommend purchasing one of our lens fitting tools which 
eliminates the chance of damaging the lens when screwing the 
collar on and off). When you feel resistance on the collar give it a 
small twist to ensure tight. Should you over-tighten you risk 
cracking the lens. 

b. There is dirt in the extrusion or on rail of the x axis. On E, M and 
TMX series machines just wipe with a dry cloth (apply NO oil or 
lubricant). On C and TMK series machines place a small amount 
of oil on a cloth and wipe over Linear Rail. Do not leave thick 
residue behind as this will collect particles and wear the bearings. 

c. On E, M and TMX series machines the x-axis wheels could be 
worn or damaged. Should this be the case please contact CTR for 
replacements. 

d. Engraving settings may be incorrect (this should only be the case 
if someone has changed them after the machine has been 
installed or possibly if software has been reloaded without the 
proper configuration). Please contact CTR to regain settings / 
information as to how to work them out. 

e. The Belt tensions are loose or over tight. Please call CTR Lasers 
and ask for a member of the technical department. 

 

5.1.4. The machine is not cutting through the material.  

a. The Mirrors or Lens are dirty. If the mirrors of lens are not 
shiny/are fogged the heat from the laser is being absorbed onto 
the face of the mirrors/lens. This buildup of heat on the surface 
could lead to the mirrors/lens cracking or the coating becoming 
damaged and this is not covered by warranty. Please make a 
visual check before using the machine as damaged cannot be 

Should the above not solve the problem 

please consult CTR Lasers and ask for a member of the  

technical department. 
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reversed. For cleaning instructions visit www.ctrlasers.co.uk  
b. The alignment may be out. Should the machine be out of 

alignment you may find it cuts through over some areas of the 
bed (normally top left) but not all. For alignment instructions 
please visit www.ctrlasers.co.uk. Call-outs due to misalignment 
are chargeable as tuition on aligning the laser will have been 
given at the time of installation. Should you need clarification 
please call CTR Lasers and ask for a member of the technical 
department. 

c. The Laser is coming towards the end of its life and you need to 
order a new tube for the machine. Please call CTR Lasers to 
arrange an installation date. 

d. The focus height to the material from the nozzle is incorrect. 
Please refocus as per training given. 

 

5.1.5. The software will not download to the machine.  

You will normally get an error message "the communication is broken for 

timeout". This could be caused because the machine is not turned on, the 

USB cable is not connected, the USB cable is too long or the 5v from the 

USB Port on the pc is not sufficient to send the data in continuous stream 

(without interference). Closing the Download box and reopening can 

often solve this problem. 

 

5.1.6. Not all users on the network can access the Easycut program.  

This is purely a permission problem with regards to the rights users have 

over the program. You need to give FULL permissions to the program. 

Lasercut also needs to be installed on the local hard drive of the PC. You 

can not install it on a server and ask the PC to look there. Nor can you 

change the default directory name the program wishes to be put into. 

CTR recommend you only use Windows XP to run the software although 

it will run on Vista and Windows 7 32bit. You may need to contact CTR 

for clarification on these other operating systems. 

 

5.1.7. Files will not import to Easycut.  

Once you have selected "File" "Import" if you do not see a preview of the 

file, in almost all cases it will not import. This will be a problem with the file 

format/design. Should you need clarification please call CTR Lasers and 

ask for a member of the technical department. 

 

5.1.8. The file imports but the laser does not cut or engrave parts.  

a. This will normally be caused by design faults. Please make sure 
all parts to be engraved have been united together. Refer to 
training or ring CTR for clarification. 

b. The Laser is not firing. Refer to Section 9.2 of the 
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troubleshooting guide. 
 

5.1.9. My machine only cuts in the top left corner.  

This will be due to the "immediate" button on the software being ticked. 

By selecting this button the job will run from the position the head of the 

machine is placed at. Unselect and the job will run from the position on 

the bed relative to the position on the software. 

 

5.1.10. Soft stop comes up on the display when trying to run a job.  

"Soft Stop" means your job would exceed the workable area of the bed. 

Please adjust your design, make sure (if on immediate) you have left 

enough room to run the job or unselect "immediate" to run from software 

related position. 

 

5.1.11. I have downloaded a revision but machine runs a previous job. 

When you download a job you need to make sure that at some point after 

this the file name has been highlighted. When a job has finished at the 

bottom of the machine display you will see TIME and a value. If you just 

download a file now and press start the machine will have held the 

previous program in memory and run that. To solve, after finishing a job 

press ESC on the control panel and you will see the screen refresh. You 

are now free to download and run your next job without problems. 

 

5.1.12. My laser power seems low. 

WARNING NOTE: Any person undertaking these checks must be 

competent and fully understand the risks associated in performing 

these checks. They must have received training from the CTR 

technician at the time of installation of the machine and be one of 

the signatories of the training completion form.  

If any of these conditions is not met, CTR will not accept any 

responsibility for injury or damage. 

 

If your CTR laser machine appears to not be cutting to the expected full 

power, you can perform the following checks before calling a technician. 

This may avoid a service callout charge. 

 

a. Make sure that you have entered the correct settings for the laser 

speed and power. 

b. Check your laser machine with a material from a batch which you 

have previously processed successfully. This will ensure that the laser 

power has not dropped due to a particularly resilient material. 

c. Make sure that the water flow through the laser tube is not restricted  
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- no kinks or bends in the tubing. Check that the water is flowing 

freely. 

d. Make sure that the water level in your water cooling unit is not too low 

- not below the level of the pump. 

e. Make sure that the water is clean. You should use distilled water in 

your cooling unit, and it should not be discoloured or have particles in 

it, as this may damage the laser tube. 

f. Make sure there are no cracks in the glass laser tube. This can be 

done by removing the back cover on the laser machine and looking to 

see if there is any sign of water in the outer part of the laser tube.  

WARNING - do not touch either end of the laser tube. 

Only a trained person should undertake this task. 

g. Check the mirror alignment across the entire bed (instructions 

available online), making sure that the laser beam is not hitting near 

the extreme edges of any mirror (the beam should be as central as 

possible). 

h. Make sure the laser beam is coming out of the centre of the lens (the 

last part before the laser beam hits the material). If it is not central, 

this could cause a drop in laser power. 

i. Make sure all of the mirrors and both sides of the lens are clean.  

Be careful when removing the lens and mirrors to ensure you do not 

scratch it.  

DO NOT over-tighten the collar when putting the lens back in place - it 

only needs a light tweak to secure it.  

j. Make sure the extraction system is not blocked or obstructed, as a 

clear extraction system will help to keep the mirrors as clean as 

possible and reduce smoke in the laser path. 

k. CHECK-NOTE: As a final check for the mirrors, put three layers of 

masking tape over the hole on the lens assembly where the laser 

beam enters. Then, check the beam alignment at the bottom left and 

bottom right ends of the laser bed by test firing the laser VERY 

BRIEFLY, leaving a burn mark on the tape. Make sure the beam is 

hitting in the same place on the masking tape. If the alignment is ok, 

check the top right end of the laser bed. If all of these are correctly 

aligned, then the X-Y axis mirrors are aligned correctly.  

l. NOTE: The laser beam needs to be entering the middle of the hole on 

the lens assembly.  

 

IF YOU EXPERIENCE FAULTS OTHER THAN THESE  

OR THE SUGGESTED RESOLUTIONS HAVE NO EFFECT PLEASE 

CONTACT CTR LASERS ON 0844 800 4727 OR EMAIL 

SALES@CTRFUTURE.CO.UK AND OUR TEAM WILL BE  

HAPPY TO HELP RESOLVE ANY ISSUES AS QUICKLY AS POSSIBLE. 
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